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1. 0Bתקציר 
בצורה נסתרת המשובצת א מעין "טביעת אצבע" יהטבעת "סימן מים" בתוכנה לצורך אימות זיהוי ה

. רישיון זה ניתן לשלוף כאשר נדרש ולטעון על בתוכנה שימוש ןכרישיובקוד, ולמעשה משמשת 

 של התוכנה. )או חוסר אותנטיות(אותנטיות 

 Collberg–Thomborson (CT)בפרויקט זה ממומש ומודגם בצורה מלאה האלגוריתם של 

 Watermarking Dynamic Software -]. האלגוריתם הינו אלגוריתם מלא ל1[-המתואר היטב ב

מומש תוך בניית  ם. האלגורית Dynamic Graph Watermarking (DGW)הממומש באמצעות

 תשתית גנרית (ספריות ותכנית) להטמעתו בצורה אוטומטית בתוכניות מארחות.

מתוארות  4.1לפרטיו. בסעיף  CTניתן רקע בנושא סימן מים בתוכנה ומתואר אלגוריתם  3בסעיף 

למימוש הספריות שנבחרו הארכיטקטורה, אלגוריתמי עזר, מתאר את  4.2. סעיף סביבת העבודה

מתאר  5.1. סעיף ממשק המשתמשמתאר את  4.3סעיף  וגרפי הרצף. הגדרת המחלקות,, הפרויקט

דן בתוצאות ומסיק  5.2חילוץ של סימן מים מתוכנית מארחת וסעיף ביצוע בפועל של פעולת הטמעה ו

 הוא הסעיף המסכם את הפרויקט. 6מסקנות. סעיף 

 

2. 1Bמטרת הפרויקט 

 Collberg–Thomborsonה את האלגוריתם שלמטרת הפרויקט היא לממש ולהדגים בצורה מלא

(CT) ואשר הינו האלגוריתם המרכזי שנסקר בעבודת הגמר שבצעתי במסגרת 1[-המתואר היטב ב [

 התואר השני.

המאפשר להם להטמיע סימן מים  Microsoft .Netהמימוש יצר כלי שימושי ליוצרי תוכנות בסביבת 

טית מלאה וללא כל התערבות ידנית בקוד שיצרו על (שנבחר על ידם), בתוכנית שלהם בצורה אוטומ

סמך קלט (סודי) שיבחרו. כמו כן, מאפשר הכלי לחלץ את סימן המים מתוכניות שבהם הוא הוטמע, 

 גם כן בצורה אוטומטית.
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3. 2Bמבוא 
בעולם האינטרנט של ימינו ישנה חשיבות הולכת וגדלה לטיפול בנושא גניבת תוכנה. הקלות שבהורדת 

תוכנות לא מורשות מהרשת מאפשרת ליותר ויותר אנשים לעשות בהם שימוש (במודע או שלא 

-של ה . סקר]4[ 2016מיליארד דולר בשנת  52במודע). הסכום המוערך של שווי תוכנות אלה עומד על 

BSA מראה בנוסף גם על קשר הדוק בין תוכנה שאינה מורשית לתוכנות זדוניות  ]4[ 2016-מ

 ולמתקפות סייבר.

 Ownershipאחד האמצעים המוצעים להקטנת תופעה זו הינו באמצעות מנגנוני "הוכחת בעלות" (

Authenticationטות אחת השיומאגד בתוכו שיטות ואלגוריתמים רבים,  ). תחום זה נחקר רבות

 ).Watermark embeddingהמוצעות הינה הטבעת "סימן מים" בתוכנה (

שימש ואשר  בוליםו ניירות ערך, שטרות כסףב המונח "סימן מים" מוכר לנו כטכניקה המיושמת

ויצירתו מצריכה טיפול ממבט ראשון  שאינו נראהומשמש כאמצעי לזיהוי זיופים על ידי יצירת סימון 

 .הדפסתו לפני ניירב

 תחוםה. מנסה ליישם טכניקה זו לשם אותה המטרה בעולם התוכנההטבעת "סימן מים" בתוכנה 

זה עוסק תחום  (steganography)אליו משתייכות טכניקות אלו בתוכנה הוא תחום הסטנוגרפיה 

בטכניקות של החבאת מסר סודי בתוך מסר מארח כאשר המטרה היא לאפשר לשני צדדים לתקשר 

מבלי לעורר חשד מצד מצוטטים פוטנציאלים. הפרסום הראשון בנושא הטבעת "סימן ובחשאיות 

(ואף נרשם   Davidson and Myhrvold [7]במאמרם של 1996-מים" בתוכנה הופיע לראשונה ב

ואחרים הציעו לראשונה אלגוריתם מפורט. מאז פורסמו מספר רב של  Collberg, 1999נת כפטנט). בש

 מאמרים ואלגוריתמים בנושא, ופותחו מספר כלים מסחריים ולמטרות מחקר.
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3.1. 3Bהטמעת סימן מים בתוכנה 

 בצורה הבאה: Software Watermarking-ניתן לתאר את בעיית ה

• P – .אוסף התוכניות המיועדות לסימון 

• W – .אוסף הסימונים 

 .'pכך שנוצרת תוכנית  P-השייכת ל pבתוכנית  wמשבץ  Software Watermarking .א

הייתה חשופה לשינויים בקוד כמו תרגום  'pגם אם  'p-מ wניתן בצורה אמינה לאתר ולחלץ את  .ב

)Translation) מיטוב ,(Optimization) וההאפלה (Obfuscation.( 

 ).Stealthניתנת להסתרה ( – w .ג

 ).High Data Rateיש תכולת נתונים גבוהה ( w –ל  .ד

 .pאינה פוגעת בביצועים של  p-ב wהטמעת  .ה

 אינה מקרית אלא מכוונת.  p'-יש תכונה מתמטית המאפשרת לטעון שנוכחותה ב  w–ל  .ו

 ובשפה תיאורית:

בצת בה מזהה ייחודי עבור בוב, כך שנוצרת , היא משpלפני שאליס מוכרת את התוכנית שלה  .א

 :Pid=Bobתוכנית חדשה 

 

החשוד כמועתק היא מחלצת את הזהות של הרוכש המקורי  pכאשר אליס מאתרת עותק של  .ב

 מהתוכנית החשודה ויכולה להשתמש בזה כטיעון משפטי נגדו.

 

במשחק הזה מניחים שבוב יודע את אלגוריתם השיבוץ והחילוץ שבשימוש על ידי אליס אך אינו  .ג

-מ p'id=Bobיודע את סימן המים וגם לא את המפתח הסודי. המטרה של בוב היא לייצר עותק 

pid=Bob  ימבלי לפגוע בישימותה של התכנית כך שאליס לא תוכל לחלץ ממנה את המזהה הייחוד 

 שלו.
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3.2. 4BCT Algorithm 

מאמר בו הם מרחיבים ומשכללים את  Collberg and Thomborson ]1[ פרסמו 2007בשנת 

. האלגוריתם בונה בזמן ריצה מבנה נתונים דינמי CT Algorithmהאלגוריתם שלהם, הנקרא על שמם 

(גרף) המייצג את טביעת האצבע בהתאם לקלט (סודי) שנבחר מראש. בזמן הריצה, הקלט גורם לקטעי 

), שאותה יש לחלץ במקרה הצורך, ראוי heapהערימה ( ןבזיכרוקוד שונים לרוץ וכך נבנית החתימה 

 .javaשפת לציין שהאלגוריתם שתיארו הותאם למימוש ב

 

 תיאור האלגוריתם בצורה כללית: 

, האלגוריתם מונה מספר סוגים פוטנציאליים Gשל גרף  המשובץ בטופולוגי Wסימן המים  .1

 למימוש:

• Permutation encoding – .מומש בפרויקט 

• Radix encoding – .מומש בפרויקט 

• Parent-Pointer Trees 

• Reducible Permutation Graphs (RPG) 

• Planted Plane Cubic Trees (PPTC) 

 …,G1, G2 הגרף מפוצל למספר תתי גרף .2

 ,I0קלט סודי  ןעבור כל תת גרף נבנה קטע קוד המשובץ בתוכנית בנתיבים בהם היא עוברת בהינת .3

I1,…. 

, הגרף המייצג את סימן …,I0, I1בזמן חילוץ סימן המים מריצים את התוכנית עם הקלט הסודי  .4

 ) , מחלצים את הגרף וחושפים את סימן המים.heap memoryערימה (ה ןזיכרובהמים נבנה 
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 CTאלגוריתם  – 1איור 

 

 להלן עיקרם : ,חלקים 4-האלגוריתם עצמו מורכב מ

1. Annotation – )Mark (תסורקים את קוד התוכנית ומשבצים בקוד התוכנה קריאות לפונקציי 

mark() למעט רישום ל אשר למעשה אינה עושות דבר בזמן הריצה-trace log  שהתכנית אכן

ביקרה בה. קריאות אלו מפזרים במקומות בהם התוכנית מקבלת החלטות הסתעפות על סמך 

 אלו יוחלפו בפונקציות לבניית גרף סימן המים). ()markקלט המשתמש (חלק מפונקציות 

2.  Tracing –  יצה של התכנית עם סדרת קלט , מבצעים ר1לאחר שלבI במהלך הריצה חלק .

 .trace-יבוצעו וירשמו ב ()markמפונקציות 

3. Embedding –  כאן מייצרים את הגרף המייצג את סימן המים (בד"כ זה יהיה מספר או מחרוזת

שהומרה למספר) ומשבצים אותו בתוכנית. יש לקבל כקלט סימן מים לשיבוץ, לאחר מכן יש צורך 

P 

 סימן מים
W 

שיבו
 ץ

Key 
i1,i2,…,n 

 

n4=CreateNode() 
n5=CreateNode() 
addEdge(n4,n5) 
addEdge(n1,n4) 
addEdge(n5 n1) 
n1=CreateNode() 
n2=CreateNode() 
n3=CreateNode() 
addEdge(n1,n2) 
addEdge(n1,n3) 
addEdge(n2 n3) 

p
 

p2 

p
 

p4 

Pw 

 

 חילוץ 

 

G 

  

G
 

G2 

 
G 

 סימן מים
W 

 

Hea
 

 חילוץ יצירה

 



9 
 

ת המספר באמצעות גרף. על מנת לבצע זאת נעשה שימוש במספר אלגוריתמים שונים בהם לייצג א

המספר על ידי פרמוטציה או קידוד בסיס. את תוצאת הפרמוטציה או קידוד הבסיס ניתן  גייצו

לייצג בגרף. לאחר מכן מייצרים את קטעי הקוד לבניית הגרף ומשבצים את קטעי הקוד הללו 

ומייצרים תוכנית חדשה. כאן למעשה הסתיים  trace-שהופיעו ב ()mark-במקום פונקציות ה

 תהליך שיבוץ סימן המים בתוכנה.

4. Extraction –  על מנת לחלץ את סימן המים מריצים את התוכנית עם הקלט הסודי, כתוצאה מכך

). לאחר שהתכנית קיבלה את כל סדרת הקלט heapהערימה ( ןייבנה גרף סימן המים בזיכרו

זה, ומהגרף המחולץ יש לחשוף את סימן המים, כלומר את  ןיש לחלץ את הגרף מזיכרו הסודי,

 המספר המייצג אותו.

 

 :ובפירוט

 המשמש להטמעה ולחילוץ "סימן המים". kהאלגוריתם מניח קיום מפתח סודי 

k הוא סדרה של קלטים  I0, I1,… .לתוכנית 

 ) / annotationmark(או סימון כתיבת הערות  – 1שלב 

לפני שניתן לשבץ את "סימן המים" בתוכנית המשתמש חייב להוסיף נקודות סימון לתוכנית. נקודות 

 אלו הינם קריאות לפרוצדורות (פונקציות) מהצורה הבאה:

mark(); 

למעשה אינה מבצעת דבר. קריאות אלו מהוות אך ורק אינדיקציות בקוד עבור  ()markהקריאה 

ת נקודות פוטנציאליות בקוד התוכנית בהם יוטבעו חלקים מ"סימן מטביע "סימן המים" והם מסמנו

סדרת קלטים על ידי  ןהמים". קריאות אלו עוזרות להבחין בנתיבים בקוד בהם התוכנית עוברת בהינת

המשתמש (אשר למעשה תפעיל את בניית הגרף המייצג את "סימן המים"), נתיבים אלו הם חלק 

 נית (הלא מסומנת). תוצאתי של ריצה נורמלית של התוכ

סדרת הקלטים יכולה להיות לחיצות מקלדת, תנועות ולחיצות עכבר/מסך מגע, קבצים, מחרוזות, 

 .'וכווידאו, אודיו, נתונים ביומטריים, מסרי תקשורת 
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 )tracingמעקב ( – 2שלב 

לאחר שלב הסימון, מריצים את התוכנית המסומנת ל"ריצת מעקב". התוכנית רצה עם סדרת הקלטים 

. חלק ()markהסודית המוזנת על ידי המשתמש. במהלך הריצה, תתבצע קריאה אחת או יותר של 

מנקודות "הפגיעה" הללו יהיו למעשה המקומות בקוד אשר בהם מטמיע "סימן המים" יטמיע חלקים 

 מים.מסימן ה

 

 )embeddingשיבוץ ( – 3שלב 

). אם Integerבמהלך שלב זה, המשתמש מזין את "טביעת האצבע", למעשה מחרוזת או מספר שלם (

הזין מחרוזת, היא מומרת למספר שלם. ממספר זה מייצרים גרף מייצג, כך שטופולוגית הגרף מייצגת 

נקודות "הפגיעה") יוחלפו כעת עם  הרלוונטיות (מאלה שהיו ()mark -את המספר. עתה, קריאות ה

 הקוד לבניית הגרף.

 

 

 .גרפי קידוד לסימן המים – 2איור 
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 בסיסי CTמחלקה לפני ואחרי אלגוריתם  –דוגמא  – 3איור 

מציג דוגמא פשוטה לכיצד תיראה  בסיסי CTמחלקה לפני ואחרי אלגוריתם  –דוגמא  – 3איור 

כך  Simple_Wשונתה לתוכנית  Simpleהתוכנית לאחר הטבעת "סימן המים". התוכנית המקורית 

יבנה בזיכרון הערימה הגרף המייצג את  "World"שכאשר היא תורץ עם קלט סודי שהוא הארגומנט 

היו עוברות ערפול בכדי למנוע מתקפת  Watermark-ו Simple_W"סימן המים". במימוש טיפוסי 

 זיהוי תבניות.

 

 )extractionחילוץ ( – 4שלב 

במהלך שלב החילוץ, מריצים את התוכנית שוב עם סדרת הקלט הסודית. אותם מקומות בהם היו 

שבוקרו בשלב המעקב ייקראו שוב. אך עתה, מקומות אלו יכילו קוד לבניית הגרף  ()markקריאות 

המייצג את "טביעת האצבע". כאשר הוזן הקלט האחרון בסדרה למעשה הושלמה בניית הגרף בזיכרון 

הערימה. כעת נותר לבדוק את זיכרון הערימה אשר בו נמצא הגרף ולנסות לאתר אותו, לחלץ אותו 

 וד הפוך מגרף למספר אשר מדווח למשתמש.ולבצע קיד
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שלב זה הוא השלב הקשה והמורכב ביותר למימוש בעיקר משום שיש צורך לחקור את זיכרון הערימה 

של תוכנית על ידי תוכנית אחרת ולנסות לחלץ ממנו גרף תקף, אשר ייתכן והוא הגרף המייצג את 

 "טביעת האצבע" שהוטמעה.

הערימה,  ןזיכרוחקור את לדרכים  2הציע  javaשפת למימוש בהאלגוריתם המאמר שהתאים את 

ואילו במימוש האלגוריתם בפרויקט זה החילוץ התבצע בדרך שלישית, אחרת (כאמור, המימוש כאן 

 הוא בשפה ובסביבה  שונה) . 

 הציעו מפתחי האלגוריתם: javaמימוש שלב החילוץ המותאם לשפת ב

 java.lang.Objectחלקת הבסיס של עצמי ג'אווה ) של מ(Constructor הבנאיאת  לשנות .1

 ולהכניס בה מונה, בצורה הבאה:

 

 CT-התאמת הבנאי של מחלקת הבסיס ל – 4איור 

מכיוון שבנייה של כל עצם בשפת ג'אווה מחייבת קריאה למחלקת הבסיס ולבנאי זה, המשמעות היא 

הערימה וזאת בעלות זמן של תוספת השמה  ןבתוכנית בזיכרושהכנסנו את סדר ההקצאה של העצמים 

בתים) סטטי לכל העצמים  long )8של משתנה אחד מסוג  ןאחת ופעולת חיבור אחת ובתוספת זיכרו

 ואחד עבור כל עצם.

אך גישה זו אינה מעשית, מכיוון שהיא דורשת לשנות את ספריות הריצה הבסיסיות של שפת ג'אווה, 

חלק מהמהדרים הקיימים של השפה יבצעו אופטימיזציה ויבטלו תוספת זו יותר מזה סביר ש

 ).ןשל זמן ריצה וזיכרו ה(אופטימיזצי

 ):portableגישה אחרת, יותר קשה למימוש אך יותר יבילה ( הוצעהולכן 

מוסיפים נקודת עצירה לכל בנאי בתוכנית. בכל פעם שמתרחשת הקצאה של  JDI-על ידי שימוש ב .2

(או כל  1000עצם מוסיפים מצביע לחציץ מעגלי אשר מצביע לעצם זה. בצורה כזו ניתן לגשת אל 
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אלגוריתם  – 5איור הערימה. ניתן לראות זאת ב ןמספר אחר) העצמים האחרונים שהוקצו בזיכרו

 .CT -נאיבי לחילוץ סימן המים ב

החיסרון העיקרי הוא בהאטה משמעותית בביצועי התכנית בזמן החילוץ עצמו עקב הצורך לטפל 

 בנקודות העצירה.

בכדי לחלץ את הגרף המייצג את סימן המים, יש לעבור על העצמים בסדר הפוך לסדר יצירתם ולחפש 

תת גרף נגיש עד שימצא אחד כזה. חילוץ טביעת האצבע מהגרף ניתן לביצוע על ידי האלגוריתם 

 .הערימה ןאלגוריתם נאיבי לחילוץ טביעת אצבע המיוצג על ידי גרף מזיכרו – 6איור בהנאיבי שמוצג 

 

 CT -אלגוריתם נאיבי לחילוץ סימן המים ב – 5איור 

בזמן החילוץ.  ן, ניתן לראות את מצב הזיכרוCT -אלגוריתם נאיבי לחילוץ סימן המים ב – 5איור ב

הערימה. המחלץ יבדוק את  ןחציץ מעגלי מכיל מצביעים לכל העצמים האחרונים שנוצרו בזיכרו

 ויחפש את שורש הגרף שיכול לשמש כגרף המייצג טביעת אצבע.  החציץ בסדר הפוך לסדר הקצאתם

 

 הערימה  ןאלגוריתם נאיבי לחילוץ טביעת אצבע המיוצג על ידי גרף מזיכרו – 6איור 
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 CLR)-ספריית תוך שימוש בהדרך השלישית למימוש שלב החילוץ, אשר בוצעה בפרויקט זה נעשתה  .3

MD) [8]  Microsoft.Diagnostic.Runtime*  ,ןרצים על כל העצמים בזיכרו בצורה נאיבית.ו 

הערימה, כאשר פוגשים בעצם מסוג "סימן מים" מכניסים אותו (את תוכנו וכתובתו) לרשימה. 

(על  בסיום הריצה רצים על רשימת העצמים ומנסים למצוא את הקשרים ביניהם. בסיום ריצה זו

ומנסים למצוא התאמה למבנה הנתונים המייצג גרף תקף שנמצאו , נבדקים הקשרים הרשימה)

)Radix/Permutation(.(מספר שלם) אם נמצא כזה, מציגים את "סימן המים" שהוא מייצג , 
 

) ממנה יש לבצע את חילוץ סימן Processאת התוכנית (כתהליך,  מריצהתכנית החילוץ  .1

 המים.

 -ל ניגשים *Microsoft.Diagnostic.Runtime  [8] (CLR MD)ספרייתבאמצעות  .2

Common Language Runtime (CLR) של התהליך ׂ . 

 הערימה ולסגמנטים השונים בו. ןלזיכרו ניגשיםשל התהליך  CLR-מתוך ה .3

 עבור כל סגמנט בזיכרון הערימה ניתן לקבל את רשימת העצמים שנמצאים בו. .4

ואת הערכים (כתובת)  ןמיקומו בזיכרו) typeכמו הסוג שלו (עבור כל עצם ניתן לקבל מידע  .5

 (מערך של בתים). ןשלו בזיכרו

למצוא את קשרי ו מסוג "סימן המים"  type-המתאימים ל לעבור על העצמיםניתן כעת  .6

 ןזיכרוהכתובות של עצמים אלו ל ןהזיכרובאמצעות התאמת מצביעי וזאת  םביניההמצביעים 

 . הם נמצאובהם 

ניתן לבדוק האם מבנה הקשרים שנמצאו בין עצמים אלו מייצג גרף תקף המייצג "סימן  עתה .7

 מים". אם נמצא כזה, ניתן להציג את "סימן המים" אותו הוא מייצג (מספר שלם).
 

 

 

 

 

 

Microsoft.Diagnostic.Runtime [8] *  הנה ספריתOpen Source  אשר נכתבה על ידיMicrosoft  וניתנת

המאפשר כתיבה של כלים ותוספים  APIמחצינה  ה). הספריירישיון חופשי מתירני( MIT ןתחת רישיו

)Plugins) לטובת ביצוע ניפוי שגיאות (debugger במוצרים מבוססי (.Net.  
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4. 5Bמימוש הפרויקט 

הרעיון שבבסיס הפרויקט הוא לבנות יישום כללי, מעין כלי תשתיתי, כך שבקלות ובצורה אוטומטית 

ניתן יהיה לבנות ולהטמיע, ולאחר מכן לחלץ את סימן המים ל/מכל תכנית מארחת (כמובן שרק 

 ).Microsoft .Netעבור תכניות שנבנו בטכנולוגיה שנבחרה למימוש כאן, 

 הבאים:הפרויקט מורכב מהחלקים 

 ניתוח האלגוריתם ודרישותיו ועיצוב הארכיטקטורה הנדרשת למימושו. .א

 .מימוש הארכיטקטורה .ב

 בנית תוכנית המדגימה את האלגוריתם והשימוש בו. .ג

 תכולות הפיתוח:

לגרף במספר שיטות שונות (מבני נתונים) (המתקבל כקלט) הפיכת מספר סודי  .א

Permutation / Radix  ) םאלגוריתבאמצעות  unrank1]6[(,  וחלוקת הגרף למודולים

 .יבוץלש

) xmlפים, אפשרות לשנות את פריסתם, לשמור אותם כקובץ (ויזואליזציה של הגר .ב

 ולהדפיסם.

במקומות  בקוד התוכנית המארחת markשיבוץ של נקודות מציאה ו -שלב הסימון  .ג

 .תקפים

תוך כדי הרצתה, ) traceמציאת נקודות בתוכנית המארחת לשיבוץ הגרף ( -שלב המעקב  .ד

 בהתאם לקלט סודי.

בהתאם לתוצאות שלב  בתוכנית המארחת(מודולים) שיבוץ חלקי הגרף  -שלב השיבוץ  .ה

 המעקב ובניית התוכנית בה מוטמע סימן המים.

למעשה חילוץ האובייקטים בה מוטמע סימן המים.  מהתכניתחילוץ הגרף  -שלב החילוץ  .ו

תוך כדי ריצתו, וחיפוש הגרף באובייקטים  של תהליך אחר )heap-ההערימה ( ןזיכרומ

 של הגרף המתקבל. תיקוףאלו לאחר הזנת הקלט הסודי וביצוע 

 ויזואליזציה של הגרף המחולץ והפיכת הגרף חזרה למספר הסודי. .ז

 עלז)  –(סעיפים א  שימוש בתוכנית שאפתח של הדגמה - תאמתיהדגמה על תוכנית  .ח

 (כתוכנית מארחת). תתוכנית אחר
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4.1. 6Bסביבת הפיתוח 

 .#Cנכתב למימוש בשפת ג'אווה, אולם אני בחרתי לממשו בשפת  CTאמנם אלגוריתם 

) SandMark ]3[ בחרתי שלא להיעזר במימושים זמינים לאלגוריתם שפותחו בעבר (כדוגמת הכלי

ויזואלית של גרף ולפתח בעצמי את כל הנדרש, למעט שתי ספריות צד שלישי המשמשות לצורך הצגה 

 ולצורך חקירת זיכרון ערימה של תוכנית (יפורט בהמשך).

, אם כי היא יכולה לרוץ גם על מערכות הפעלה Windows 10המערכת פותחה עבור מערכת ההפעלה 

Windows  ) קודמותWin 7 / Win 8 בהתאמות קלות. כמו כן נבחר ( 

Framework 4 Client Profile  עבור הפיתוח בסביבתMicrosoft .Net. 

 .Visual Studio 2015 Community Version) נבחרה להיות IDEסביבת הפיתוח (

 .Windows Formsבה נעשה השימוש הנה  UI-טכנולוגית ה

 

4.2. 7BCTWM ארכיטקטורה 
 

 כללי 4.2.1
השלבים המפורטים  4-לביצוע הפרויקט היה הצמדות ל ההקו המנחה בבניית הארכיטקטור

המודולים, המחלקות, המתודות וממשק המשתמש תוכננו בהתאם. ניתן לראות , ולכן CTבאלגוריתם 

 ].4.2.3) [sequence Diagrams] ובתרשימי הרצף (4.2.2זאת בעיקר בעיצוב ממשק המשתמש [

 

 מחלקותהשמות והמרחבי  ,מודולים 4.2.2
מורכבת מתוכנית ראשית  CTWM (Collberg Thomborson Water Marking)התכנית שפותחה 

)executable) וממספר מודולים (Class Libraries/ dlls חלקם בשימוש אצל היישום המטמיע (

וחלקם בשימוש אצל התוכנית המארחת את סימן המים. כמו כן, כאמור, נעשה  )CTWMשפותח (

 שימוש בשתי ספריות צד שלישי.

 

 סימן המים: שלוש הספריות הבאות נמצאות בשימוש היישום המטמיע והן בתוכנית בה הוטמע .א

 

1 Auxilary.dll (Class Library) 

• Namespace Auxilary 

o class GeneralDefs 
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 והגדרות כלליות. קבועיםמחזיקה 

o class Auxilary 

מכילה פרוצדורות כלליות לטיפול בקבצים (העתקות, כתיבות וקריאות), ומתודות כלליות להרצת 

 תהליכים.

 

2 MarkPoints.dll (Class Library) 

• Namespace MarkPoints 

o class MarkPoints 

 על התוכנית המארחת. trace-שנקראות בזמן ביצוע ה mark-מטפלת בסימון נקודות ה

 

 

3 Graphs.dll (Class Library) 

• Namespace Graphs 

o class Graph 

 מחלקה כללית למימוש גרף.

o class PermutationGraph 

 ומרחיבה אותו לצורך ייצוג וטיפול בגרפי פרמוטציה. Graph-יורשת מ

o class RadixGraph 

 ומרחיבה אותו לצורך ייצוג וטיפול בגרפי בסיס. Graph-יורשת מ
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 Auxilary, MarkPoint - תרשימי המחלקות - 7 איור

 

 

 Graph -ות המחלק םתרשי -8  איור
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  :)3rd Partyהמודולים הבאים הם מצד שלישי (שני  .ב
 

 GraphViewerGDI  -וMicrosoft Automatic Graph Layout (MSAGL) [9]  מודול  1

 לטובת הצגת הגרפים המייצגים את סימן המים. ]10[
 

לטובת קריאת זיכרון הערימה של תוכנית  Runtime [8]  Diagnostic Microsoftמודול 2

 ).Reflection-מתוכנית אחרת (עושה שימוש ב

 

 

המכילה את ממשק המשתמש הראשי ובנויה  CTWM.exeנבנתה תוכנית ראשית בשם  .ג

 ) הבאות:classes) והמחלקות (namespacesממרחבי השמות (

• namespace CTWM.About  

o class About : Form  
 גרסה, תאריך, ויוצר.טופס להצגת מספר 

• namespace CTWM.AuxilaryWM 

o class Constants 
 התכנית קבועי

o class Auxilary 
 מתודות עזר כלליות לתוכנית

o class Exceptions 
 טיפול בחריגות

 

o class Wizard 

 Wizard -טיפול בתהליכי ה

• namespace CTWM.CreateWM 

o class Permutation 
 יצירת סימן מים מסוג פרמוטציה

o class Radix 
 יצירת סימן מים מסוג קידוד בסיס

 

• namespace CTWM.EmbedWM 

o class EmbedWM 
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 שלב שיבוץ סימן המיםביצוע 

• namespace CTWM.ExtractWM 

o class ExtractedRawGraph : IEnumerator, IEnumerable 

o class ExtractedRawNode 

o class PeExtractedRawGraph : ExtractedRawGraph 

o class RadixExtractedRawGraph : ExtractedRawGraph 
 חילוץ ובניית הגרף המייצג את סימן המים

o class ExtractWM 
 בניית סימן המים מהגרף שחולץ

 

• namespace CTWM.MarkWM 

o class MarkWM 
 שלב הסימוןביצוע 

• namespace CTWM.Settings 

o class Settings : FORM 
 .טופס לשינוי הגדרות כלליות

• namespace CTWM.ShowWM 

o class ShowWM : Form 
 טופס להצגה ויזואלית של הגרף המייצג את סימן המים

• namespace CTWM.TraceWM 

o class TraceWM 
 שלב המעקבביצוע 

• namespace CTWM 

o class FormCTWM: Form 

o class Program (Main) 
 , המכיל את ממשק המשתמש. טופס התוכנית הראשי
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 CTWM -ות המחלק םתרשי - 9 איור
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 תרשימי הרצף 4.2.3
יצירת  - CT) עבור השלבים המרכזיים באלגוריתם Sequence Diagramsלהלן תרשימי הרצף (

 סימן המים, סימון התוכנית, המעקב, השיבוץ והחילוץ.

 

 

 

 שלב יצירת סימן המים –תרשים הרצף  – 10 איור
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 שלב הסימון –תרשים הרצף  – 11 איור

 

 שלב המעקב –תרשים הרצף  – 12 איור
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 שלב שיבוץ הגרף המייצג את סימן המים –תרשים הרצף  – 13 איור
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 שלב חילוץ הגרף המייצג את סימן המים –תרשים הרצף  – 14 איור
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 תוכנית הדגמה (מארחת) 4.2.4

לצורך הדגמת מימוש האלגוריתם. תוכנית זו מממשת  Calculatorנבנתה תוכנית נוספת בשם 

  מחשבון פשוט.

 

 ממשק המשתמש -Calculator  – 15 איור

 

 תרשים מחלקות -Calculator  – 16 איור
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4.3. 8BCTWM ממשק משתמש 

 ממשק המשתמש מורכב מטופס ראשי אשר מחולק למספר רכיבים:

 )Menusתפריטים ( •

 )Tabs and Buttonsהפעלות ( •

 )Outputsדוחות ( •

 

 

 CTWMממשק המשתמש  - 17איור 

 

 

 תפריטים 4.2.2
1. File 

• WM Wizard – הפעלה/כיבוי ה-Wizard. 

• Create WM  -  פותח אתTab .יצירת סימן המים 

• Mark –  פותח אתTab .סימון התוכנית 

• Trace PTS –  פותח אתTab .ביצוע המעקב 

• Embed WM  -  פותח אתTab .שיבוץ סימן המים 

• Extract WM –  פותח אתTab .חילוץ סימן המים 
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2. Edit 

• Settings – שרות לבחור את סוג המהדר פותח את טופס ההגדרות הכללי המכיל אפ

)msbuild.exe) ותצורת ההידור (debug/release.( 

 

3. View 

• ILDASM –  פותח את התוכניתILDASM.exe (Intermediate Language 

Disassembler) .עם התוכנית עבורה בוצע שיבוץ או חילוץ סימן המים 

 

4. Help 

• About –  פותח את טופסAbout .המכיל מספר גרסה, תאריך, והיוצר 

 

 

 הפעלות 4.2.2
 רכיב ההפעלות מורכב מ:

 .WM Embedding Wizardתיבת סימון להפעלה או כיבוי  .1

2. Creation Tab  - 2-מאפשר הזנת מספר (סימן המים) והפיכתו לגרף המייצג אותו ב 

פרמוטציה וקידוד בסיס. כמו כן ניתן לצפות וויזואלית בגרף שנוצר,  –אלגוריתמים שונים 

 וכו'. לקובץ, להדפיסו לשנות את גודלו ואת פריסתו, לשמור אותו
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 Creation Tab ממשק משתמש – 18איור 

3. Marking Tab – )Annotation ( פעיל רק כאשר נמצאים במצבWizard  והמשתמש יצר

. מאפשר לבחור תוכנית קלט אשר עבורה יבוצעו הסימונים של Creation Tab -סימן מים ב

כל המקומות האפשריים והרלוונטיים להטמיע את חלקי הגרף המייצג את סימן המים 

 ) מה התבצע והיכן בתוכנית בשלב זה.Outputsשנבחר. ניתן לצפות ברכיב הדוחות (

 

 Marking Tab ממשק משתמש – 19איור 
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4. Trace Tab -  פעיל רק כאשר נמצאים במצבWizard והמשתמש ביצע את שלב ה-

Marking מאפשר לבחור את התוכנית בה בוצע הסימון, מריץ אותה ומבצע .Trace  על סמך

) מה Outputsהקלט שקיבלה (הקוד הסודי של המשתמש). .ניתן לצפות ברכיב הדוחות (

 התבצע והיכן בתוכנית בשלב זה.

 

 Tracing Tab ממשק משתמש – 20איור 

 

5. Embedding Tab -  פעיל רק כאשר נמצאים במצבWizard והמשתמש ביצע את שלב ה-

Trace מאפשר לשבץ את סימן המים (ניתן עכשיו לבחור אחד אחר) התוכנית שעברה .Mark 

מסתיים שלב השיבוץ, ונוצרת תוכנית חדשה אשר הגרף המייצג את  . בסיום שלב זהTrace-ו

 סימן המים שובץ בתוכה על סמך הקוד הסודי שהתקבל כקלט בתוכנית.
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 Embedding Tab ממשק משתמש – 21איור 

 

6. Extraction Tab – אינו תלוי במצב ה-Wizard) לנסות לחלץ)  -ליתר דיוק . מאפשר לחלץ

את הגרף המייצג את סימן המים מתוכנית ולהמירו חזרה למספר שנבחר להיות סימן המים 

וזאת תוך כדי ריצת התוכנית המסומנת המקבלת את הקלט הסודית. המשתמש יתבקש 

לבחור את התוכנית ממנה ירצה לחלץ את סימן המים, ואת סוג סימן המים שהוטמע בה (לא 

תפתח התוכנית שנבחרה  "Extract Water Mark"חיצה על הכרחי), לאחר מכן בל

והמשתמש יתבקש להזין לה את הקלט הסודי. לאחר שהוזן הקלט הסודי יודיע על כך 

המשתמש לתוכנית החילוץ והיא תתחיל לחקור את זיכרון הערימה של התוכנית המחולצת 

כדי ריצה יודפסו כל . תוך tab-(שעדיין רצה וחייבת לרוץ) ותציג בר התקדמות בתחתית ה

יודפסו כל  Extraction-הערימה ברכיב הדוחות, ובטופס ב ןהעצמים שנמצאו בזיכרו

הערימה מסוג הגרף שהוטמע. בסוף הריצה על זיכרון הערימה  ןהעצמים שנמצאו בזיכרו

להרכיב מהעצמים שנמצאו גרף מייצג חוקי, אם נמצא כזה יתבצע אלגוריתם  ןיתבצע ניסיו

. ניתן WM found-המים (מספר) מהגרף שנמצא. אם נמצא כזה המספר יוצג  ב לחילוץ סימן

 גם להציג וויזואלית את הגרף שנמצא (אם נמצא).
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 Extraction Tab ממשק משתמש – 22איור 

 

 דוחות 4.2.2
רכיב הדוחות מציג דוח פעילות עבור כל שלב בביצוע הטבעת סימן המים וכן בשלב חילוץ סימן 

 המים 
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 Outputs ממשק משתמש – 23איור 

ניתן לראות את הדוח לשלב החילוץ, כאן מוצגים כל  Outputs ממשק משתמש – 13איור ב

העצמים שחולצו מזיכרון הערימה של התוכנית, בכחול בולט, יוצגו העצמים שקשורים לגרף 

 סימן המים.
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5. 9B ,ומסקנות דוגמאותתוצאות 

 .Calculatorעל התוכנית  CTWMההרצה בוצעה באמצעות 

5.1.   10Bדוגמאות הרצה 

 

 "2233445566פרמוטציה וגרף מייצג עבור סימן המים " - Creation – 24איור 
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 "2233445566קידוד בסיס וגרף מייצג עבור סימן המים " – Creation  – 25איור 

 

 )Calculator2 )1סימון התוכנית  – Marking  – 26איור 
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 )Calculator2 )2סימון התוכנית  – Marking  – 27איור 

 

 

 )Calculator )1על התוכנית  עם קוד סודי ביצוע מעקב – Tracing  – 28איור 

  -עם הקוד הסודי (קלט סודי) 
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1. Edit -> Scientific 

2. Radians 

3. 44 

4. Sin 

5. * 

6. 9 

7. = 

8. View ->History 

9. Help -> About 

 

 

 )Calculator )2על התוכנית עם קוד סודי ביצוע מעקב  – Tracing  – 29איור 
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 )Calculator )3על התוכנית עם קוד סודי ביצוע מעקב  – Tracing  – 30איור 

 

 

" 2233445566שיבוץ גרף הפרמוטציה המייצג את סימן המים " – Embedding  – 31איור 
 Calculatorבתוכנית 
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 )Calculator )1חילוץ סימן המים מהתוכנית  – Extraction  – 32איור 

 

 

 )Calculator )2חילוץ סימן המים מהתוכנית  – Extraction  – 33איור 
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, לאחר הזנת הקלט הסודי Calculatorמוצלח של סימן המים מהתוכנית  חילוץ  – 34איור 
)3( 

) של כתומהמוקפים במסגרת (הערימה  ןניתן לראות את רשימת כל העצמים שחולצו מזיכרו

), את אלו מביניהם שמרכיבים את הגרף המייצג כחולהבמסגרת  תפמוק( Calculatorתוכנית ה

ואת סימן  )סגולה במסגרתמוקף ), את הגרף שחולץ (הירוק במסגרת פיםמוקאת סימן המים (

 )אדומהמוקף במסגרת המים עצמו (
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 Calculatorסיום לא מוצלח של חילוץ סימן המים מהתוכנית  - Extraction  – 35איור 
 )4( לאחר הזנת קלט שאינו הקלט הסודי

) וזאת השחור מוקפים במסגרתנבנו עצמים המרכיבים את הגרף (הערימה  ןשבזיכרושימו לב 

גרף  עצמים אלה אינם מייצגיםהקיימים בקלט הסודי, אולם  רכיביםמכיוון שהקלט שהוזן מכיל 

 ). אדומהמוקפת במסגרת  No results – התוצאהמים (הסימן  חילצה אתלא התוכנית תקין ולכן 
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הוטמע בה  שלא Calculatorביצוע חילוץ (כושל) על תוכנית  ןניסיו - Extraction  – 36איור 
 )5סימן מים, ברור שאינה מניבה תוצאות ללא תלות בקלט (
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שהוטמע בה סימן מים באמצעות  Calculatorניתוח התכנית  – ILDASM  – 37איור 
ILDASM  

ניתן להבחין בקריאות ליצירת הגרף בפונקציות של התוכנית. כאן בפונקציה 

ScientificToolStripMenuItem_Click מוקפת במסגרת  ישנה קריאה להוספת צומת לגרף)

  .)אדומה
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5.2. 11Bומסקנות תוצאות 

 
 ומוצא תוצאות, בכל המקרים שנבדקו.היטב המימוש עובד 

 :בזמן המימוש בעיות, הבעיות העיקריות שהתגלום נטולי אינ והמימוש האלגוריתם

, ניתן להתגבר על ILDASMסימן המים אינו חבוי, ניתן לראות את הקריאות ליצירתו באמצעות  •

טריוויאלי),  המימוש אינוכמו כן ניתן להכניס דמויים ( ).Obfuscationכך על ידי ביצוע ערפול (

בצורה שאינה  רשיגרמו לגרף להיווצ ואמתיות ליצירת הגרף, או כאל ןכלומר קריאות שאינ

 כאשר מוזן קלט שאינו תקין.נה תקי

בבחירת המקומות בקוד בהם יש לבצע פעולות הקשורות ליצירת הגרף, יש לבחור מקומות בהם  •

עם אחת ויחידה במהלך הזנת הקלט הסודי, אחרת יש צורך בסימון מיוחד התכנית עברה פ

המציין את מספר הביקורים באותה שורה בתכנית בזמן ריצה, דבר המסבך מאוד את הטמעת 

סימן המים  ובנוסף פעולה חריגה זו עלולה לעורר חשד אצל תוקף שעלול לזהות כי נקודה זו 

 קשורה ליצירת סימן המים.

קלט אינו משנה במימוש זה, לצורך העניין  אם הקלט הסודי (על תוכנית המחשבון) סדר הזנת ה •

 יעבוד. "= 5 * 8+  3"אזי גם הקלט  "= 3+  8 * 5" הוא

אם הקלט הסודי שהוזן הוא תת קבוצה של הקלט שנבדק אזי גם ייתכן שייבנה הגרף המתאים  •

 הערימה וייתכן שיחולץ סימן המים. ןבזיכרו

סימני  כלנצפו מקרים בהם חולץ יותר מגרף אחד שמתאים לקידוד ולכן, במקרים כאלו הוצגו  •

 כאשר סימן המים הוא מספר קטן. תופעה זו קוראת לרובמים שנמצאו. ה

 ככל שגודל התוכנית עולה.מעט זמני הריצה בכל שלבי השיבוץ הם זניחים, ועולים  •

בכמות העצמים שהוקצו בערימה בזמן ביצוע זמן הריצה בזמן החילוץ הוא משמעותי ותלוי  •

 8וזיכרון של  I7, במחשב עם מעבד אינטל 5בפרק  דוגמאעבור ה. ובעצמת המחשב המבצע החילוץ

gb ram  13%דקות ( 2:30-עצמים היה כ 56,518משך החילוץ בסריקה של סה"כ cpu.( 

, עבור סימן 5יתנה בפרק בדוגמה שנגודל התוכנית בה מוטמע סימן המים גדל. בתוכנית המחשבון  •

בתים  26,112(מ   debugאחוזים בהידור בתצורת  2% -כהייתה עליה של מים מסוג פרמוטציה, 

 בתים). 25,600-בתים ל 24,576(מ  release בהידור בתצורת  4%-בתים), ובכ 26,624-ל 

סימן  וטמעת גדולה יותר. לדוגמא, הטמעתככל שסימן המים המוטמע גדול יותר התוכנית המ •

תוכנית הגדילה את  release" מסוג פרמוטציה בתצורת 223344556677889911המים "

 בתים). 26,112-בתים ל 25,600-(מ 2% -בכ 5, ביחס לדוגמא בסעיף המחשבון

טנה יותר מאשר פרמוטציה הטמעת סימן מים באמצעות קידוד בסיס יוצרת לרוב תוכנית מעט ק •

  בתוכנית המחשבון). 2%-(עד כ
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6.  12Bסיכום 

מתחילתו ועד סופו והדגים אותו על תכנית אמיתית. התשתית  CTהפרויקט מימש את אלגוריתם 

 .C# .Net-שנוצרה בפרויקט יכולה לשמש כאמצעי להזנת סימן מים בתוכניות הכתובות ב

הוא  CTלמרות זאת, לגבי השאלה האם שימוש בהטמעת סימן מים בתוכנה באמצעות אלגוריתם 

לתת עליהם ו עמיד, התשובה אינה חד משמעית שכן הוא מראה חולשות ובעיות שיש יעיל, שימושי א

 את הדעת, הרחבה בנושא ניתנת בעבודה המסכמת.
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